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Microsoft Project 2010   
 

 
 

What is Project 2010?   
 
Project 2010 

 Microsoft Project 2010 is Microsoft's answer to project management. It 
provides all the tools you need for effective planning, tracking, problem 
solving, sharing, and completing a project in keeping with conventional 
management principles and practices. 

 
It can be used for a project of any size. It simply provides a framework to start with, 
as well as the means to organise and manage effectively.  It is like having a project 
management assistant. 

 

 

 In this session you will learn how to use the basic features of Microsoft Project 

to manage your projects. By the end of the session you will be able to: 

o Enter tasks and their duration 

o Modify tasks 

o Create dependencies between tasks 

o Create a list of resources and assign them to tasks 

o View reports and track the progress of your project 
 

 

The Project 2010 Environment   
 

Starting Project 2010 

 We will begin by opening Project 2010. 

o Click on Start. 

o Click on Programs. 

o Click on Microsoft Office. 

o Click on Microsoft Office Project 2010. 

 Project 2010 opens with a new blank project displayed in the default Gantt 

Chart view. 
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The Gantt Chart View 

 The Project file has been opened in Gantt Chart view. 

 The Gantt Chart view is Project’s default view. It consists of a Gantt table (on 
the left) and a Gantt Chart (on the right). The Gantt table is made up of 
columns of information, and the Gantt Chart is the graphic representation of 
the information entered. 

 

 The Gantt Chart view is useful for entering task information and for viewing 

the timing and relationship between tasks. 

 The Gantt table on the left displays information in columns such as: 

o Task Name – showing the different tasks and subtasks which are involved in 

the project 

o Duration, Start and Finish - The estimated duration of each of the tasks or 

subtasks, including start and finish dates 

o Predecessors – Indicates the relationship of a subtask to other tasks, if any 

exists 

o Resource Names – displays the resources assigned to each task or subtask, 
e.g. personnel or materials. 

Note: we will consider each of these categories in more detail later on in this 
session. 

 The two windows on your screen can be resized so that you can view 
a larger or smaller portion of the window. To resize, simply hover your 
mouse cursor over the grey vertical divider until it becomes a double- 
headed arrow.  Click and drag the line until it is in the position you 
desire. 

o Practice this now by clicking and dragging the vertical divider to the 

left, to decrease the size of the Gantt table on the left, and increase 

the size of the Gantt Chart on the right. 
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How the Gantt Chart Displays Information 

 You will notice that the Gantt Chart displays different types of task in different 

ways. The most common of these are outlined below: 
 

Type of Task Description Gantt Chart Representations 

Normal All tasks that are not 

milestones or summary tasks. 

Blue bar 

 

Milestone Either a task with a zero 
duration, or a task that has 
been designated as a 
milestone. 

Black diamond 

 
 

Summary Tasks that represent the 
duration of the tasks 
subordinate to them in an 
outline. 

Black bar 

 
 

 

Critical* A task or series of tasks that 
must be completed on 
schedule in order for a project 
to finish on schedule. 

Red bar 

 
 

 

Finished Tasks for which an actual finish 
date has been entered or that 
have been marked 100% 
complete. 

Blue bar with black centre 

 
 

 
In Progress Tasks for which an actual start 

date but not an actual finish 
date, has been entered. 

Blue bar with black progress 

line 

 

* Note: to view the critical tasks in Gantt Chart view you need to display the 
Detail Gantt chart. To do this: 

 Click on the View tab towards the centre of the Ribbon. 

 Click on the down-arrow to the right of Other Views in the 

Resource Views group towards the centre of the Ribbon. 

 Click on More Views. 

 Select Detail Gantt in the More Views dialogue box. 

 Click on [Apply]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Now close the file, by clicking on the lower grey Close button  at the top 
right of the screen. 

 When the dialogue box appears asking you if you would like to save the changes, 

choose [No]. 
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Defining the Project   
 

 
 

Starting a New Project 

 We will now start a new project; to do this: 

o Click on the File tab at the left of the Ribbon. 

o Click on New. 

o Double-click on Blank project below the Available Templates heading. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: Alternatively you may use the default blank presentation that displays 
when Project is first accessed.  However, it may be preferable to follow the 
above procedure if you wish to be sure that the file is completely new. 

 

 
 

Entering Start and Finish Dates   
 
Inputting Start and Finish Dates 

 The first step in starting a new project is establishing basic project information. 

The start or finish date is what you will use to anchor your project. Your 

schedule will be built around either the start date or the finish date that you 

choose. 

 
 The start and finish date information is entered in the Project Information 

dialogue box, which we will open now. To do this: 

o Click on the Project tab around the centre-left of the Ribbon. 
 
 
 
 
 
 
 

 
o Click on Project Information in the Properties group at the left of the 

Ribbon to display the Project Information dialogue box. 
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o Depending on what you choose from the Schedule from: drop-down menu 
(Project Start Date is the default), either the Start date: or Finish date: will 
be available for you to enter a date into. 

o You can either type in the date, or click the down-arrow to display a pop-up 
calendar to select a date. 

 

 

 Typically, the other fields (Current date:, Status date: and Calendar:) can be 

left as the default values. 

o In this case use the drop-down calendar in the Start date: field to select 
Monday, February 20, 2012 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

o We will also set the Current date: so that we can easily see the project’s start 
date. Therefore use the drop-down calendar in the Current date: field to 
change the date to Sunday, February 19, 2012 

 

 

 Project supplies three basic calendars (Standard, Night Shift and 24 Hours) 

o In this case ensure that Standard is selected from the Calendar: drop-down 

menu. 
 

 
 
 
 
 
 
 
 
 
 

o Click [OK] to close the Project Information dialogue box. 

o You will be returned to the Gantt Chart view where you will notice that the 
dates you specified in the Project Information dialogue box are now 
displayed in the Gantt Chart. 

 

 Note: The Status date: is used to record when the project was updated to 
reflect changes in task durations, costs etc, and is used to identify differences 
between what was expected and what actually happened. 

 

 It should be noted that all of this information can be changed at any time 
throughout your project, which can be useful in trying out "what-if" scenarios in 
the planning stage. 
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Entering Tasks   
 

 

Tasks are the specific activities that must be completed in order to finish your 
project (i.e. a 'to-do' list). 

Your task list is the backbone of your project plan. It is essential to create your task 

list as comprehensively as possible because if a required task is omitted, you may 

not be able to achieve all of your goals. It is beneficial to create your task list in 

approximately the same order as the tasks will be performed, although it is not 
necessary to be completely accurate as there are ways to edit, add, delete and 

move tasks. 

 
Automatic verses Manual Scheduling 

 In contrast to previous versions which automatically arranged the scheduling of 

tasks, Project 2010 offers the facility to manually arrange the scheduling of tasks. 

 This may be useful where you want full control over the scheduling of your 
project’s task. However, for our current project we will let Project do the 
scheduling for us. 

 

 

 As Project 2010 applies Manual Scheduling by default we now need to 

change this to Automatic Scheduling. To do this: 

o Click on the New Tasks: Manually 

Scheduled button at the left of the status 

bar at the bottom of the screen. 

o Select Auto Scheduled – Task dates 
are calculated by Microsoft Project 
from the menu that displays. 
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Entering Tasks 

 There are a couple of ways to enter a new task. The first is to click in the Task 
Name column in the first empty row of the Gantt table and enter the task name. 
 

 After you accept the information, the task is assigned an ID number that is 
displayed in the far left column. This is useful for establishing relationships 
between tasks, such as successors and predecessors. 

 

 

 Project uses 1 day as the default length for estimated task durations. Project 
notifies you that this is an estimated date by displaying a question mark (?) at 
the end of the entry. 
If your estimate for the duration of your task is different than one day, you can 
change it, however we will leave these default start and finish dates as they are 
for now (amending start and finish dates will be covered later on in this session). 

 
 
 
 
 
 
 
 

Note: the other type of duration that project can display is an actual duration, 

which shows the span of actual working time for a task so far, in other words 

once a task is actually underway. 
 

 

 Click on Save in the Quick Access Toolbar at the top-left of the screen to save 

the changes. 
 

Entering Subtasks   
 

Entering Subtasks 

 Subordinate tasks, or subtasks, are used to break large tasks into smaller 

units until you reach the level of detail you want. This can be useful in the 

displaying and printing of your project. 

 By breaking large tasks into smaller, more manageable tasks, you may be able to 
schedule them to run concurrently, and thereby reduce both the duration of the 
task and the duration of the project. 

 
 

 

 To make our new task a subtask of another task: 

o Ensure that subtask (to be) is selected by clicking on it if necessary. 
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o Click on the Task tab at the left of the Ribbon. 

o Click on the Indent Task button in the Schedule group at the centre-left of 

the Ribbon. 
 

 
 
 
 
 
 
 

o You should notice that the higher-level task has now become what is known as 
the summary task, and its representation in the Gantt Chart has changed to 
reflect this. 

 
 
 
 
 
 
 
 
 

 

Editing the Notes for a Task 

 Once a Note has been added to a task it is easy to edit it, for example to include 

updated details. To do this: 

o Double-click on the Notes icon in the Information column to the left of the 
Create an Outline task. 

o The Task Information dialogue box opens displaying the Notes pane. 

o Make any necessary changes and when you have finished click on click on 
[OK] to close the dialogue box. 

 

 

Inserting, Moving and Deleting Tasks 

 To insert an additional task between two existing tasks 

o Right-click on the ID number below the position you want to insert the new 

task. 

o Select Insert Task from the menu that displays. A new blank row is created. 

o Click within the new cell under the Task Name heading to obtain an insertion 

point. 

o Enter the name for the new task. 

o Press [Enter] to accept the change. 
 

 To move a task 

o Click on the ID number for the task that you want to move to select the 
entire row.  

o Now click again on the ID number and drag the task to its new position. As 

you do so a grey horizontal bar displays to indicate where the task will be 

positioned. 

o When you are happy that it is in the correct place release the mouse button. 
 

 To delete a task 

o Click on the ID number for the task that you want to delete.  

o Press [Delete] on the keyboard. The task is deleted. 
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Creating Dependencies   
 

Establishing Dependencies 

 Dependencies are a way to link tasks together in order to describe which tasks 
must precede or succeed one another – in other words, some tasks must start 
or finish before another task can begin or end. Creating dependencies 
allows Project to create a flexible time framework relative to the task preceding 
or succeeding it. 

 There are two types of tasks in a dependency.  A predecessor task must occur 

before another task. A successor task must occur after another task. 
 

 

 There are four different types of dependencies (or linkages) that can be 

assigned to a task or tasks. These are described below. 
 

Dependency Description 

Finish-to-Start 

(FS) 

This is the most common type of relationship. 

The start of one task begins as soon as its predecessor 

finishes. The successor can't start until the predecessor 

finishes. 

E.g. A report must be finished before it can start to be edited. 
Start-to-Finish 

(SF) 

This requires the successor task is completed after its 

predecessor starts. 

That is, the successor task cannot finish until the predecessor 

task starts. 

This relationship is rarely used, although it may be necessary in 

unusual instances. 

E.g. Employees can start using a new procedure only after they 

have finished being trained. 

Start-to-Start 

(SS) 

This is where the successor cannot start until the predecessor 

starts. 

The tasks can happen simultaneously, but the predecessor has 

to have started in order for the successor to start. 

E.g. One you start to receive results you can start to process 
them. 

Finish-to-Finish 
(FF) 

This is where the successor can't finish until the predecessor 
finishes. 

The tasks can happen simultaneously, but the predecessor has 

to have finished in order for the successor to finish. 

E.g. The computer installation is finished at the same time as 

employees finish moving in so that they can start work 

immediately 
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Resources   
 

 

Creating a Resource List   
 

 
 

Creating Resources 

 Resources are people, supplies and equipment that you need to use to 

accomplish your tasks and goals. 

 Project uses the resource information you provide to make the schedule for 
your project – typically the more resources you assign, the shorter the duration 
of the project will be. This is because a task is completed faster when there are 
more people or materials assigned to it. 

 

 
 
 

Using the Resource Sheet View 

 One of the best ways to enter resources is by using the Resource Sheet view, 

which we will open now. To do this: 

o Click on the View tab at the centre-left of the Ribbon. 

o Click on Resource Sheet (not the down-arrow) in the Resource Views 
group towards the left of the Ribbon. 

 

 
 
 
 
 
 
 

 The Resource Sheet view is useful for viewing, entering and editing resource 

information.  It contains detailed resource information in a worksheet format. 
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Setting the Resource Type 

 Once you have entered a resource you should notice that Project has assigned 

some default values to the resource, of which one of these is the resource Type. 

 Project allows you to choose either Work (human resources), Material or Cost 

as the resource Type. 

Note: Do be aware that if the file is viewed in Project 2003 any Cost type is 
converted to Material. Therefore do not use this option if sharing the file with 
anyone using this earlier version. 

 

 

 We will now change the resource Type for Postage to 

cost. To do this: 

o Click in the Type column to the right of Postage. 

o Select Cost from the drop-down list. 

o Click anywhere away from the cell you have just 

updated. 
 

 

 Click on Save in the Quick Access Toolbar at the top-left of the screen to save 

the changes. 
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Entering Working Time   
 
Entering Working Time 

 Where necessary you can customise a resource's availability during the project by 

modifying their project calendar. 

 To customise a calendar: 

o Open the Resource Information dialogue box by double-clicking on the 

Resource Name in the Resource Sheet. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Click on the General tab and click on the [Change Working Time] button at 

the right of the dialogue box. 

o Ensure that Standard is selected in the Base calendar: panel. 

o If necessary use the scroll bar to the right of the calendar to scroll to 
February 2012. 

o Click on the date 21 February 2012. This is going to be an Exception Day 
i.e. a day away from work, or nonworking day, for our resource. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Ensure the Exceptions tab towards the bottom of the dialogue box is 

selected. 

o Click in the Name panel and type in a reason for not being available on that 

date. In this case enter Day off. 

 
o Click in the panel at the right under the Start heading. 21 February 2012 

will automatically be entered. 

Note: If this occurs regularly, click on [Details] to the right of the panel and specify 
how often this occurs in the Recurrence pattern panel. 

 

 

o Click on [OK] to close the Change Working Time dialogue box. 

o Click on [OK] to close the Resource Information dialogue box. 
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Entering Costs   
 

Entering Rates 

 It is important to enter rates for a resource, even if they are estimates, as this 

allows Project to calculate the overall cost of a project. 

 The cost of a resource may increase or decrease during the life of your project, 

and you need to be able to reflect these changes. 

 
 You can enter some rates for a resource. To do this: 

o In the Resource Sheet double-click to select the Std. Rate cell for the 

resource to open the Resource Information dialogue box. 

o Click on the Costs tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Type in the Standard Rate column to record the normal pay rate. 

o Press [Enter] to accept the entry. 

o Enter an Overtime Rate if required. 

o Press [Enter] to accept the entry. 

o When you have finished click on [OK] to close the dialogue box. 
 

 

 Click on Save in the Quick Access Toolbar at the top-left of the screen to save 

the changes. 
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Assigning Resources   
 

 

 Now we have entered some resources information we can assign these 

resources to particular parts of your project. To do this: 

o Begin by redisplaying the Gantt Chart by 
clicking on the View tab at the centre left 
of the Ribbon. 

o Then click on Gantt Chart (not the down- 

arrow) in the Task Views group at the left 

of the Ribbon. 
 

 

o In the Gantt Chart view, click on the Resource Names 
column for the Research New Product task. 

Note: If necessary resize the Gantt table to fully view the 
Resources Names column by dragging the vertical divider to the 
right. 

 

 

o Click on the down-arrow and select from the list that displays to associate to 

this task. 

o Press [Enter] to accept the change. 
 

 

 Another way of achieving this is by using the Task Information dialogue box. 

o Double-click on the task to open the Task Information  
dialogue box. 

o Click on the Resources tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Click within the first blank cell below the Resource Name heading to obtain 

an insertion point and then click on the drop-down arrow that appears to the 

right of the panel. 

 
 You will notice that the names of the resources that you have assigned have 

appeared in the Gantt Chart to the right of the tasks to which they relate. 

 Now close the file, by clicking on its lower grey Close button .  When the 
dialogue box appears asking you if you would like to save your changes, choose 
[No]. 
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Updating and Tracking Projects   
 

 

Setting the Baseline   
 

 
 

Understanding Baselines 

 The baseline is a picture or image you capture of the project plan the moment 

planning is complete. 

 It is used to track the planned progress of the project against the actual 

progress. It provides a point of reference when tracking your project. 

 With smaller projects, one baseline is usually sufficient because planning is 
usually close to what actually happened. With larger projects, however, several 
baselines may be required because projects can move far off the planned path. 
Project 2010 allows you to save 11 different baselines and 11 interim plans. 

 
 

Setting the Baseline 

 We will now set a Baseline to record the current position of the project. To do 

this: 

o Click on the Project tab towards the left of the Ribbon. 

o Click on Set Baseline in the 

Scheduling group at the centre of the 

Ribbon to display a menu. 

o Select Set Baseline to display the 

Set Baseline dialogue box. 

 

o Ensure that the Set Baseline check box displays a check mark. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o In this case we want to record the entire project, so ensure that the Entire 

project check box under the For: heading displays a check mark. 

o Click [OK] to save the baseline information and close the dialogue box. 
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Recording Actuals - Tasks   
 

 

 Once a project is underway, it is important to collect and record data on task 
progress to show what has actually occurred. This allows Project to 
automatically reschedule the remaining tasks and gives tangible ways to measure 
progress (when compared to the baseline). 

 When updating and recording actuals the Gantt Chart is the best view to 

work from. 
 
 
 

Setting Actual Start and Finish Dates 

 Recording the actual start or finish date of a task is critical to the overall finish 
date of the project. If tasks are finishing on time, the project is likely to finish on 
time, and conversely, if tasks are completed behind schedule, the project is likely 
to finish behind time. 

 

 

o Click on the Task tab at the left of the Ribbon. 

o Click on the Display Task Details button at the right of the Properties 
group on the Ribbon. 

 

 
 
 
 
 
 
 

o The Task Details Form appears in the bottom half of the screen. 
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o In the top pane of your screen, select the task in question by clicking within it 

in the Task Name column. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o We wish to specify the actual date this task started, therefore in the bottom 

pane, choose Actual from the option buttons at the bottom of the Dates 

panel. 
 

 

o We will also record that the task is now 100% complete.  So to do this click on 

the up/down arrows to the right of the % complete: text box toward the right of 

the dialogue box so that it displays 100%. 

o When you have finished click on [OK] at the top of the dialogue box to accept 

the changes. 

 You will notice a tickmark has appeared in the  Information column next to 
the task in the top half of the screen. This indicates that the task has been 
completed. 

 The Gantt Chart entry also displays a full black band in the task, indicating 

that it is complete. 
 

 We no longer need the Task Details Form, therefore to remove it and view the 

Gantt Table and Chart in full screen mode: 

o Click on the Task tab at the left of the Ribbon. 

o Click on the Display Task Details button at the right of the Properties 
group on the Ribbon. 
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Setting Actual Task Durations 

 In a similar way, it is possible to record the actual duration of tasks. To do this: 

o Begin by clicking on the task you would like to update to select it. 
o Click on the Task tab at the left of the Ribbon. 

o Click on the down-arrow to the right of the Mark on Track button in the 
Schedule group at the centre of the Ribbon to display a menu. 

 
 
 
 
 
 
 
 
 

 
o Select Update Tasks to display the Update Tasks dialogue box. 

 

 

o To specify that the duration of a task was two days, not one as expected: 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Therefore use the up-arrow to the right of the Actual dur: option box to 

change the actual duration of this task to 2d (2 days). 

o Click [OK] to accept the change and close the dialogue box. 

o You will notice a tick mark has appeared in the Information column next to 

the task at the top of the screen, indicating that the task has been completed. 

o You will also see that the duration has changed to 2 days, and that 
subsequent dates have been altered to reflect that this part of the Project took 
longer than originally planned. 

 

 

 Click on Save in the Quick Access Toolbar at the top-left of the screen to save 

the changes. 
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Views   
 

 

Introduction to Views   
 Project includes a number of different Views, which enable you to see the project 

from a variety of perspectives and focus on different aspects. 

 So far we have used the Gantt Chart view, which is the default view, and the 

Resource Sheet view. 

 Two other views we will look at now are Task Usage and Calendar. 

 You can use most views to enter and edit information, although some views can 

only display information. 
 

 

 The Views available can all be accessed from the More Views dialogue box, 
which can be accessed by clicking on the down-arrow on most of the view 
buttons. 

 For example, to do this: 

o Click on the down-arrow at the bottom of 
the Gantt Chart button at the left of the 
Task or View tab on the Ribbon. 

o Select More Views from the bottom of 

the menu that displays. 

o We will not use this dialogue box, so close 

it by clicking on [Cancel]. 
 
 
 

Using the Task Usage View 

 The Task Usage View can be considered to be a composite of the Gantt 

Table and the Properties Sheet, as it displays both the tasks and the 

associated resources together. 

 To access this from its own button: 

o Click on the View tab at the centre- 

left of the Ribbon. 

o Click on Task Usage button (not 
the down-arrow) in the Task Views 
group at the left of the Ribbon. 

 

 
 
 
 
 
 
 
 
 

 When you have finished return to the Gantt Chart 
view by clicking on Gantt Chart (not the down-
arrow) in the Task Views group at the left of the 
Ribbon. 
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Using the Calendar View 

 The calendar view is useful for a general overview of what needs to be done on a 

specific day. 

 To access this from its own button: 

o Click on the View tab at the centre-left 

of the Ribbon. 

o Click on Calendar button (not its 

down-arrow) in the Task Views group 

at the left of the Ribbon. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 When using this the main points to consider are: 

o You can switch from Monthly view to Weekly view by clicking on the buttons 

at the top-left of the actual calendar. 

o You can scroll through the months by using the arrow buttons immediately 

below the Month/Week buttons. 

o A black box surrounds the current date. 

o Tasks are shown by a bar stretching over the amount of days allocated for the 

task. 

o A solid black bar shows the project’s milestones. 

o You can double-click on any of the tasks to open the Task Information 
dialogue box and view specific information about that task. 
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Using the Reports 

 
 A number of reports are readily available inside Project 2010. 

 These can easily be selected by clicking onto the Project ribbon and then Reports. 

 The following box will appear, showing the categories of reports available. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Of all the reports available, the following are the most widely used: 
 

Category Report name 

Overview 
Project Summary 

Top-level Tasks 

Current 
Tasks in Progress 

Slipping Tasks 

Costs 
Budget 

Over-budget Tasks 

Assignments 

Who Does What 

Who Does What When 

To-do List 

 
If you wish to change the contents or layout of a report (not recommended), you should use 
the Custom category and after selecting the report in question, clicking the Edit button. 


